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1 Introduction 
1.1 About this Manual 

This manual provides information on how to set up AS-Interface Slave 
devices described with EDS files. These devices can be configured with the 
AS-Interface generic Slave DTM within an FDT Framework. 
 

Dialog Panes 
The table below gives an overview for the individual dialog panes 
descriptions: 
 

Section Subsection Manual  
Page 

Configuration General  20 
 Configuration 21 
 Signal Configuration 24 
Device Description Device Info 25 
Diagnosis General Diagnosis 28 

Table 1  Descriptions Dialog Panes 

 

1.1.1 Online Help 
The generic AS-Interface Slave DTM contains an integrated online help 
facility. 

 To open the online help, click on Help or press F1. 
 
. 
 
 
 
 

1.1.2 List of Revisions 
Index Date Version Chapter Revision 
6 17-02-23 1.10 (and 1.0010) 1.4.1    Section Requirements, Internet access, Windows 8.1 

and Windwos 10 added. 
7 18-02-14 1.10 (and 1.0010)        Versioning information revised: Title page and this 

section 

Table 2: List of Revisions 
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1.1.3 Conventions in this Manual 

Notes, operation instructions and results of operation steps are marked as 
follows: 

Notes 
 
 

 

Important: <important note you must follow to avoid malfunction> 

 

 

Note:  <general note> 

 

 

<note, where to find further information> 

 

Operation Instructions 
 

1. <instruction> 

2. <instruction> 
 

or 
 

 <instruction> 

 

Results 
 

 <result> 
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1.2 Legal Notes 

Copyright 
© Hilscher Gesellschaft für Systemautomation mbH 

All rights reserved. 

The images, photographs and texts in the accompanying materials (in the 
form of a user's manual, operator's manual, Statement of Work document 
and all other document types, support texts, documentation, etc.) are 
protected by German and international copyright and by international trade 
and protective provisions. Without the prior written consent, you do not 
have permission to duplicate them either in full or in part using technical or 
mechanical methods (print, photocopy or any other method), to edit them 
using electronic systems or to transfer them. You are not permitted to make 
changes to copyright notices, markings, trademarks or ownership 
declarations. Illustrations are provided without taking the patent situation 
into account. Any company names and product designations provided in 
this document may be brands or trademarks by the corresponding owner 
and may be protected under trademark, brand or patent law. Any form of 
further use shall require the express consent from the relevant owner of the 
rights. 

Important notes 
Utmost care was/is given in the preparation of the documentation at hand 
consisting of a user's manual, operating manual and any other document 
type and accompanying texts. However, errors cannot be ruled out. 
Therefore, we cannot assume any guarantee or legal responsibility for 
erroneous information or liability of any kind. You are hereby made aware 
that descriptions found in the user's manual, the accompanying texts and 
the documentation neither represent a guarantee nor any indication on 
proper use as stipulated in the agreement or a promised attribute. It cannot 
be ruled out that the user's manual, the accompanying texts and the 
documentation do not completely match the described attributes, standards 
or any other data for the delivered product. A warranty or guarantee with 
respect to the correctness or accuracy of the information is not assumed. 

We reserve the right to modify our products and the specifications for such 
as well as the corresponding documentation in the form of a user's manual, 
operating manual and/or any other document types and accompanying 
texts at any time and without notice without being required to notify of said 
modification. Changes shall be taken into account in future manuals and do 
not represent an obligation of any kind, in particular there shall be no right 
to have delivered documents revised. The manual delivered with the 
product shall apply. 

Under no circumstances shall Hilscher Gesellschaft für Systemautomation 
mbH be liable for direct, indirect, ancillary or subsequent damage, or for 
any loss of income, which may arise after use of the information contained 
herein. 

Liability disclaimer 
The hardware and/or software was created and tested by Hilscher 
Gesellschaft für Systemautomation mbH with utmost care and is made 
available as is. No warranty can be assumed for the performance or 
flawlessness of the hardware and/or software under all application 
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conditions and scenarios and the work results achieved by the user when 
using the hardware and/or software. Liability for any damage that may have 
occurred as a result of using the hardware and/or software or the 
corresponding documents shall be limited to an event involving willful intent 
or a grossly negligent violation of a fundamental contractual obligation. 
However, the right to assert damages due to a violation of a fundamental 
contractual obligation shall be limited to contract-typical foreseeable 
damage. 

It is hereby expressly agreed upon in particular that any use or utilization of 
the hardware and/or software in connection with 

• Flight control systems in aviation and aerospace; 

• Nuclear fusion processes in nuclear power plants; 

• Medical devices used for life support and 

• Vehicle control systems used in passenger transport 

shall be excluded. Use of the hardware and/or software in any of the 
following areas is strictly prohibited: 

• For military purposes or in weaponry; 

• For designing, engineering, maintaining or operating nuclear systems; 

• In flight safety systems, aviation and flight telecommunications systems; 

• In life-support systems; 

• In systems in which any malfunction in the hardware and/or software 
may result in physical injuries or fatalities. 

You are hereby made aware that the hardware and/or software was not 
created for use in hazardous environments, which require fail-safe control 
mechanisms. Use of the hardware and/or software in this kind of 
environment shall be at your own risk; any liability for damage or loss due 
to impermissible use shall be excluded. 

Warranty 
Hilscher Gesellschaft für Systemautomation mbH hereby guarantees that 
the software shall run without errors in accordance with the requirements 
listed in the specifications and that there were no defects on the date of 
acceptance. The warranty period shall be 12 months commencing as of the 
date of acceptance or purchase (with express declaration or implied, by 
customer's conclusive behavior, e.g. putting into operation permanently). 

The warranty obligation for equipment (hardware) we produce is 36 
months, calculated as of the date of delivery ex works. The aforementioned 
provisions shall not apply if longer warranty periods are mandatory by law 
pursuant to Section 438 (1.2) BGB, Section 479 (1) BGB and Section 634a 
(1) BGB [Bürgerliches Gesetzbuch; German Civil Code] If, despite of all 
due care taken, the delivered product should have a defect, which already 
existed at the time of the transfer of risk, it shall be at our discretion to 
either repair the product or to deliver a replacement product, subject to 
timely notification of defect. 

The warranty obligation shall not apply if the notification of defect is not 
asserted promptly, if the purchaser or third party has tampered with the 
products, if the defect is the result of natural wear, was caused by 
unfavorable operating conditions or is due to violations against our 
operating regulations or against rules of good electrical engineering 
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practice, or if our request to return the defective object is not promptly 
complied with. 

Costs of support, maintenance, customization and product care 
Please be advised that any subsequent improvement shall only be free of 
charge if a defect is found. Any form of technical support, maintenance and 
customization is not a warranty service, but instead shall be charged extra. 

Additional guarantees 
Although the hardware and software was developed and tested in-depth 
with greatest care, Hilscher Gesellschaft für Systemautomation mbH shall 
not assume any guarantee for the suitability thereof for any purpose that 
was not confirmed in writing. No guarantee can be granted whereby the 
hardware and software satisfies your requirements, or the use of the 
hardware and/or software is uninterruptable or the hardware and/or 
software is fault-free. 

It cannot be guaranteed that patents and/or ownership privileges have not 
been infringed upon or violated or that the products are free from third-party 
influence. No additional guarantees or promises shall be made as to 
whether the product is market current, free from deficiency in title, or can be 
integrated or is usable for specific purposes, unless such guarantees or 
promises are required under existing law and cannot be restricted. 

Confidentiality 
The customer hereby expressly acknowledges that this document contains 
trade secrets, information protected by copyright and other patent and 
ownership privileges as well as any related rights of Hilscher Gesellschaft 
für Systemautomation mbH. The customer agrees to treat as confidential all 
of the information made available to customer by Hilscher Gesellschaft für 
Systemautomation mbH and rights, which were disclosed by Hilscher 
Gesellschaft für Systemautomation mbH and that were made accessible as 
well as the terms and conditions of this agreement itself. 

The parties hereby agree to one another that the information that each 
party receives from the other party respectively is and shall remain the 
intellectual property of said other party, unless provided for otherwise in a 
contractual agreement. 

The customer must not allow any third party to become knowledgeable of 
this expertise and shall only provide knowledge thereof to authorized users 
as appropriate and necessary. Companies associated with the customer 
shall not be deemed third parties. The customer must obligate authorized 
users to confidentiality. The customer should only use the confidential 
information in connection with the performances specified in this 
agreement. 

The customer must not use this confidential information to his own 
advantage or for his own purposes or rather to the advantage or for the 
purpose of a third party, nor must it be used for commercial purposes and 
this confidential information must only be used to the extent provided for in 
this agreement or otherwise to the extent as expressly authorized by the 
disclosing party in written form. The customer has the right, subject to the 
obligation to confidentiality, to disclose the terms and conditions of this 
agreement directly to his legal and financial consultants as would be 
required for the customer's normal business operation. 
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Export provisions 
The delivered product (including technical data) is subject to the legal 
export and/or import laws as well as any associated regulations of various 
countries, especially such laws applicable in Germany and in the United 
States. The products / hardware / software must not be exported into such 
countries for which export is prohibited under US American export control 
laws and its supplementary provisions. You hereby agree to strictly follow 
the regulations and to yourself be responsible for observing them. You are 
hereby made aware that you may be required to obtain governmental 
approval to export, reexport or import the product. 

 

1.3 Registered Trademarks 
Windows® XP, Windows® Vista, Windows® 7, Windows® 8, Windows® 8.1 
and Windows® 10 are registered trademarks of Microsoft Corporation. 

All other mentioned trademarks are property of their respective legal 
owners. 

 

 

1.4 About Generic AS-Interface Slave DTM 
You can use the AS-Interface generic Slave DTM to configure the AS-
Interface Slave devices described with EDS files within a FDT Framework.  

The information necessary for the configuration of the AS-Interface Slave 
devices is stored within the AS-Interface Master device when using the AS-
Interface generic Slave DTM and thus the Master device is configured. 
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1.4.1 Requirements 
System Requirement 

• PC with 1 GHz processor or higher 

• Windows® XP SP3,  
Windows® Vista (32-Bit) SP2,   
Windows® 7 (32-Bit and 64-Bit) SP1,   
Windows® 8 (32-Bit and 64-Bit),  
Windows® 8.1 (32-Bit and 64-Bit),   
Windows® 10 (32-Bit and 64-Bit) 

• Administrator privilege required for installation 

• Internet Explorer 5.5 or higher 

• RAM: min. 512 MByte, recommended 1024 MByte 

• Graphic resolution: min. 1024 x 768 pixel 

• Keyboard and Mouse 

• Restriction: Touch screen is not supported. 
 

 

Note: If the project file is used on another PC,  

 the other PC must also comply to these system requirements, 

 the device description files of the devices used in the project must be 
imported to the configuration software SYCON.net on the other PC, 

 respectively the DTMs of the devices used in the project must be 
installed on the other PC. 

 

Requirements AS-Interface Generic Slave DTM 

Requirements for working with the AS-Interface generic Slave DTM are: 

• Installed FDT/DTM V 1.2 compliant frame application 

• Installed AS-Interface Master DTM 

• EDS file of the devices to be configured 

• The user needs to reload the Device Catalog 
 

Loading EDS files 
To add devices to the netDevice device catalog, you must import the EDS 
file of the used device via netDevice menu Network > Import Device 
Descriptions …. into the EDS folder of the DTM. Then the Device 
Cataloge must be reloaded. The folder EDS inclusively Windows® XP is 
located in the application data directory (All Users) of the configuration 
software (or from with Windows® 7 on in the C:\ProgramData\ SYCONnet 
directory). 
 

 

For further information refer to section Configuration Steps on page 17 , 
under step 1 and 2. 
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1.4.2 AS-Interface Slave Profiles 
Each EDS file corresponds to a Slave profile (specified by the AS-i Protocol 
specification).  

The following table shows the available Slave profiles defined each in an 
EDS file. 
 

Available AS-Interface Slave Profiles: Device Name from the EDS File 
S-0.0, Remote I/O Port 
S-0.1, Two Dual-Signal Sensor 
S-0.A, Extended Addressing Mode 
S-0.B, Safety Slave 
S-0.F, No Profile 
S-1.0, Remote I/O Port 
S-1.1, Single Sensor (ext. control.) 
S-1.A, Extended Addressing Mode 
S-1.F, No Profile 
S-2.0, Remote I/O Port 
S-2.F, No Profile 
S-3.0, Remote I/O Port 
S-3.1, One dual sensor, one dual actuator 
S-3.A, Extended Addressing Mode 
S-3.F, No Profile 
S-4.0, Remote I/O Port 
S-4.A, Extended Addressing Mode 
S-4.F, No Profile 
S-5.0, Remote I/O Port 
S-5.A, Extended Addressing Mode 
S-5.F, No Profile 
S-6.0, Remote I/O Port 
S-6.A, Extended Addressing Mode 
S-6.F, No Profile 
S-7.0, Remote I/O Port 
S-7.1, Interface for 6-18-bit Signals 
S-7.2, Interface for 6-21-bit Signals 
S-7.3, Interface for 16-bit Signals 

S-7.4, Interface for 16-bit Signals 
S-7.5, Combi field device  
S-7.A, Extended Addressing Mode 
S-7.B, Safety Slave 
S-7.D, Motor Control Device (electromechanical) 
S-7.E, Motor Control Device (semiconductor) 
S-7.F, No Profile  
S-8.0, Remote I/O Port 
S-8.1, Two Dual-Signals Actuator 
S-8.A, Extended Addressing Mode 
S-8.F, No Profile 
S-9.A, Extended Addressing Mode 
S-9.F, No Profile 
S-A.0, Remote I/O Port 
S-A.F, No Profile 
S-B.1, Dual Actuator with Feedback 
S-B.A, Extended Addressing Mode 
S-B.F, No Profile 
S-C.0, Remote I/O Port 
S-C.A, Extended Addressing Mode 
S-C.F, No Profile 
S-D.1, Single Actuator with Monitoring 
S-D.A, Extended Addressing Mode 
S-D.F, No Profile 
S-E.0, Remote I/O Port 
S-E.A, Extended Addressing Mode 
S-E.F, No Profile 

Table 3: Available AS Interface Slave Profiles 

 

The Slave profile notation for the example profile 7.A.8 is:  

• I/O Configuration code = 7 

• ID Code = A 

• Ext. ID2 code = 8 
 
 

 

For further information to the Slave profiles refer to section I/O Code, ID 
Code, ID2 Code and Slave Profiles on page 30, I/O Data Size depending 
by IO and ID Code on page 32 and to [3]. 
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1.5 Dialog Structure of the Generic AS-Interface Slave DTM 
The graphical user interface of the DTM is composed of different areas and 
elements listed hereafter: 

1. A header area containing the General Device Information, 

2. The Navigation Area (area on the left side), 

3. The Dialog Pane (main area on the right side), 

4. OK, Cancel, Apply, Help, 

5. The Status Line containing information e. g. the online-state of the 
DTM. 

 

 
Figure 1: Dialog Structure of the Generic AS-Interface Slave DTM 
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1.5.1 General Device Information 
 

Parameter Meaning 
IO Device Name of the device 

Vendor Vendor name of the device 

Device ID Identification number of the device 

Vendor ID Identification number of the vendor 

Table 4: General Device Information 

 

 

1.5.2 Navigation Area 
The Navigation Area contains folders and subfolders to open the dialog 
panes of the DTM. 
 

Navigation Area  

 Configuration 
 General 
 Configuration 
 Signal Configuration 
 Device Description 

 Device Info 

  

Figure 2: Navigation Area 

 

 Select the required folder and subfolder. 

 The corresponding Dialog pane is displayed.  

Hide / display Navigation 
 

 Hiding the navigation area (above right side). 

 
Opening the navigation area (below left side). 
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1.5.3 Dialog Panes 
At the dialog pane the Settings, Device Description or Diagnosis 
(depending by Slave) panes are opened via the corresponding folder in the 
navigation area. 
 

Configuration 
   General At the pane General the symbolic name of the generic AS-Interface Slave device station can 

be set. Further information to this you find in section General on page 20. 

   Configuration At the pane Configuration the slave data and the parameter data of the generic AS-Interface 
Slave device station can be set. Further information to this you find in section Configuration 
on page 21 

   Signal 
Configuration 

At the pane Signal Configuration for the single signals respectively the names of the tags are 
set or the data types configured. Further information to this you find in section Signal 
Configuration on page 24   

Device Description 
   Device The Device Info pane contains the manufacturer information about the device. Further 

information to this you find in section Device Info on page 25. 
Diagnosis 
   Diagnosis 
(depending by Slave) 

At the Diagnosis panes diagnosis information can be read. For further information, refer to 
section Overview Diagnosis on page 27. 

Table 5: Overview Dialog Panes 

 

 
Note: To get access to the Diagnosis panes of the Generic AS-Interface 
Slave DTM requires an online connection from the AS-Interface Slave 
DTM to the AS-Interface Master DTM.  

 
 

 

For further information, refer to section Connecting/Disconnecting Device 
on page 26. 
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1.5.4 OK, Cancel, Apply and Help 
OK, Cancel, Apply and Help you can use as described hereafter. 
 

 Meaning 
OK To confirm your latest settings, click OK. All changed values will be applied on the frame application 

database.  
The dialog then closes. 

Cancel To cancel your latest changes, click Cancel.  
Answer to the safety query Configuration data has been changed. Do you want to save the data? 
by Yes, No or Cancel. 
Yes: The changes are saved or the changed values are applied on the frame application database.  
The dialog then closes. 
No: The changes are not saved or the changed values are not applied on the frame application 
database.  
The dialog then closes. 
Cancel: Back to the DTM. 

Apply To confirm your latest settings, click Apply. All changed values will be applied on the frame application 
database.  
The dialog remains opened. 

Help To open the DTM online help, click Help.  

Table 6: OK, Cancel, Apply and Help 
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1.5.5 Status Bar 
The Status Bar displays information about the current state of the DTM. 
The current activity, e.g. the DTM connection state, is signaled graphically 
via icons in the status bar. 
 

 
Figure 3: Status Bar – Status Fields 1 to 6 

 

Status 
Field 

Icon / Meaning 

1 DTM Connection States 
 

 
Connected: Icon closed = Device is online 

 
 

Disconnected: Icon opened = Device is offline 

2 Data Source States 
 

 
Data set: The displayed data are read out from the instance data set 
(database). 

 
 

Device: The displayed data are read out from the device. 

3 States of the instance Date Set 
 

 
Valid Modified: Parameter is changed (not equal to data source). 

Table 7: Status Bar Icons [1] 

 

Offline State 
 

 

Online State 
 

 

Figure 4: Status Bar Display Example 
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2 Getting started 
 

2.1 Configuration Steps 
The following overview describes the steps to configure a AS-Interface 
Slave device with the AS-Interface generic Slave DTM as it is typical for 
many cases. At this time it is presupposed that the AS-Interface Master 
DTM installation was already done. 

The overview lists all the steps in a compressed form. For detailed 
descriptions of each step refer to the sections noted in the column For 
detailed information see section. 
 

# Step Short Description For detailed information see 
section 

Page 

1 Add AS-
Interface 
Slave in the 
Device 
Catalog 

Add the Slave in the Device Catalog by importing 
the device description file to the Device Catalog. 
Depending of the FDT Container. For netDevice: 
- Network > Import Device Descriptions. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

2 Load device 
catalog 

Depending of the FDT Container. For netDevice: 
- select Network > Device Catalog, 
- select button Reload Catalog. 

 
(See Operating Instruction 
Manual netDevice and 
netProject) 

- 

3 Create new 
project / 
Open existing 
project 

Depending of the frame application. 
For the configuration software: 
- select File > New or File > Open. 

 
(See Operating Instruction 
Manual of the Frame 
Application) 

- 

4 Insert Master 
or Slave into 
configuration 

Depending of the FDT Container. For netDevice: 
- in the Device Catalog click to the Master, 
- and insert the device via drag and drop  
to the line in the network view, 
- in the Device Catalog click to the Slave, 
- and insert the device via drag and drop  
to the Master bus line in the network view. 

- - 

5 Configure 
Slave 

Configure the Slave device. 
- Double click to the device icon of the Slave. 
- The Slave DTM configuration dialog is displayed. 
In the Slave DTM configuration dialog: 
- select Configuration > General, 
- set the symbolic name of the generic AS-Interface 
Slave device station,  
- select Configuration > Configuration, 
- set the Slave data and the parameter data,  
- select Configuration > Signal Configuration, 
- set for the single signals the names of the tags or 
the data types,  
- close the Slave DTM configuration dialog via  
the button OK. 

Configuring Slave Parameter 
 
 
 
General 
 
 
Configuration 
 
Signal Configuration 

19 
 
 
 
20 
 
 
21 
 
24 
 

6 Configuration 
Steps Master 
device 

Configure the Master device via AS-Interface 
Master DTM. 

(See Operating Instruction 
Manual DTM for AS-Interface 
Master devices) 

- 

7 Save project Depending of the frame application. 
For the configuration software: 
- select File > Save. 

 
(See Operating Instruction 
Manual of the Frame 
Application) 

- 

Table 8: Getting started - Configuration Steps 

 

For information to further steps as Diagnosis, refer to the user manual 
DTM for AS-Interface Master devices. 
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3 Configuration 
3.1 Overview Configuration 

Dialog Panes “Configuration” 
The table below gives an overview about the available Configuration 
dialog panes descriptions: 
 

Generic AS-Interface Slave 
DTM 

General  20 

Navigation Area  

 Configuration 
 General 
 Configuration 
 Signal Configuration 

  

 

Configuration 21 
Signal Configuration 24 

Table 9: Descriptions of the Dialog Panes Dialog Panes Configuration 

 

 

Notice the descriptions in the section Configuration Steps on page 17. 

 

 
Note: Access to the configuration panes is enabled without requirement of 
user rights. However for editing certain user rights are required. Further 
information can be found in section and User Rights on page 29. 
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3.2 Configuring Slave Parameters 
The following steps are needed to set the Slave device parameters using 
the AS-Interface Slave DTM:  

General 
1. Enter the symbolic name of the generic AS-Interface Slave device 

station: 

 Select Configuration > General in the navigation area.  

Configuration 
2. Set the slave data and the parameter data of the generic AS-Interface 

Slave device station: 

 Select Configuration > Configuration in the navigation area.  

Signal Configuration 
3. For the single signals configure respectively the names of the tags or 

the data types: 

 Select Configuration > Signal Configuration in the navigation area.  

Close Generic Slave DTM Configuration Dialog 
4. Click OK in order to close the Generic Slave configuration dialog and to 

store your configuration. 

Further Information 
 

 

For more information refer to section General on page 20, to section 
Configuration on page 21 or to section Signal Configuration on page 24 . 

 

 

 



Configuration 20/42 

Generic Slave DTM for AS-Interface Slave Devices | Configuration of AS-Interface Slave Devices  
DOC090604OI07EN | Revision 7 | English | 2018-03 | Released | Public  © Hilscher, 2009-2018 

3.3 General 

At the pane General the symbolic name of the generic AS-Interface Slave 
device station can be set.  

Therefore proceed as follows: 

1. Select Configuration > General in the navigation area.  

 The dialog pane General is displayed. 

 
Figure 5: Configuration > General 

 

Parameter Meaning 
Device Address The device address of the generic AS-Interface Slave device station is set in the AS-

Interface Master DTM. Here it is only displayed.  
The AS-Interface Master device transmits the device address of the generic AS-Interface 
Slave device during startup via the AS-Interface network to the generic AS-Interface Slave 
device and thereby configures the generic AS-Interface Slave device. 

Description Description of the generic AS-Interface Slave device station. 

Table 10: Explanations to the Dialog Pane General 

 

2. Under Description enter the description of the generic AS-Interface 
Slave device station. 
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3.4 Configuration 

At the pane Configuration the Slave Data and the Parameter Data of the 
generic AS-Interface Slave device station can be set. 

The Slave and Parameter Data viewed or changeable in the 
Configuration pane corresponds to the used “Slave profile” described in 
the EDS file as defined by the specification of the AS-Interface protocol [3].  
 

Proceed as follows: 

1. Select Configuration > Configuration in the navigation area.  

 The dialog pane Configuration is displayed. 

 
Figure 6: Configuration > Configuration 

 

2. Configure the Slave Data and the Parameter Data as described in 
section Configuring Slave Data on page 22 or in section Configuring 
Parameter Data on page 23. 
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3.4.1 Configuring Slave Data 
The I/O Configuration code, the ID code and the Extended ID1 
Code/Extended ID2 Code (for devices that support Extended ID2 Code) 
correspond to the used “Slave profile” and must be set device specifically. 
 

  

Profile S-7.3: Ext. ID2 code is supported Profile S-0.1: Ext. ID2 code is not supported 

Figure 7: Configuration > Configuration > Slave Data, Example Slave profiles, which support 
Ext. ID2 code or do not 

Parameter Meaning Range of 
Value/ Value 

Slave Data 

I/O 
Configuration 

I/O Configuration as specified in the EDS file.  
The first digit of the slave profile is the I/O Configuration. 

Default: depen-
ding on profile 

ID Code ID Code as specified in the EDS file.  
The second digit of the slave profile is the ID code. 
F. e. for profile S-7.A the default is A, for S-0.1 it is 1. 

Default: depen-
ding on profile 

Ext. ID1 Code Extended ID1 Code: to set by the user 0 … F, Default: 
F 

Ext. ID2 Code Extended ID2 Code: to set by the user. 
Some devices (described with the corresponding “Slave profile”/EDS file) do 
not support Extended ID2 Code. So Ext. ID2 Code is disabled and the value is 
set to the default “F”. 

0 … F, Default: 
F 

safety query: 
Current signal 
configuration 
will be lost. 
Proceed? 

Some profiles are changed, when changing the Ext. ID1 and/or Ext. ID2 
codes. I. e., the signal configuration is modified as it is bound to the slave 
profile. 
Then the safety query Current signal configuration will be lost. Proceed? 
appears. 
Answer to it by Yes or No. 
Yes: Changes of the signal configuration are reset to the values of the last 
user modification. 
No: Changes of the signal configuration are not reset to the values of the last 
user modification. 

Example 
profiles: 
query appears 
for S-7.A.8 
when changing 
the Ext. ID1 
code from 3 to 
7, 
for S-7.3 when 
changing the 
Ext. ID2 code. 

Error message: 
Internal Error! 
Creating slave 
data model 
fails 

For the profiles S-7.A.8 and S-7.A.9 there are some combinations for ext. ID1 
and ID2 codes that yield to a profile not specified by the AS-i protocol 
specification.  
In such cases, for example S-7.A.8 with ext. ID1 code 0, the Signal 
Configuration table disappears and the message provided by the AS-Interface 
Master is displayed that there is no such profile defined. 

S-7.A.8,  
S-7.A.9 
Example: 
S-7.A.8 with ext. 
ID1 code 0 

Table 11: Explanations to the Dialog Pane Configuration > Slave Data 

1. Under Ext. ID1 Code enter a value for the Extended ID1 Code. 

2. If Ext. ID2 code is supported, select under Ext. ID2 Code a value for 
the Extended ID2 Code. 
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3.4.2 Configuring Parameter Data 
The Parameter Data > Bit 0 to Bit 3 can be set or reset. 

The parameter data are vendor specific. The entries under Parameter 
Data/Bit0 … Bit 3 come from the EDS file. 
 

 

Please refer to the manual of the manufacturer to get further information 
to the parameter data. 

 

 
Figure 8: Configuration > Configuration > Parameter Data 

 

Parameter Meaning Range of 
Value/ Value 

Parameter Data 

Bit0 … Bit 3 Parameter Data Bit 1 to Bit 3: to be set by the user 
If no more information is set in the EDS file under Parameter Data/Bit0 … Bit 
3 the default Set/Reset is shown.  
If information for the Parameter Data > Bit 0 to Bit 3 is set in the EDS file, this 
information is shown. 

Set/Reset 
Default: 
Set,/Reset 

Table 12: Explanations to the Dialog Pane Configuration > Parameter Data 

 

3. Under Parameter Data/Bit0 … Bit 3 select an entry each. 
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3.5 Signal ConfigurationAt the pane Signal Configuration for the single signals 
the names of the tags can be set or the data types configured. 
 

 
Note: The configuration of the input/output signals of the Slave is 
specified by the used “Slave profile” described in the EDS file. 

 

Proceed as follows: 

1. Select Configuration > Signal Configuration in the navigation area.  

 The dialog pane Signal Configuration is displayed. 

 
Figure 9: Configuration > Signal Configuration - Example 

 

Paramete
r 

Meaning Range of Value/ 
Value 

Module Input or output module of the Signal Configuration input, output 
Tag Tags for the single input or output signals.  

The name can be set by the user. 
 

Data type Data type of the single input or output signals.  
Depending by the used AS-Interface Slave profile (EDS file) the user can 
select the data type from a list. 

BIT, 
WORD, 
SIGNED16, 
UNSIGNED16, etc., 
Default: depends by 
EDS file used 

Type Type of the single input or output signals:  
input or output (not editable) 

Input, Output 

Default Click Default, to set the signal configuration to the default values for the given 
slave profile. 
Answer to the safety query Current signal configuration will be lost. 
Proceed? by Yes or No. 
Yes: Changes of the signal configuration are reset to the default values. 
No: Changes of the signal configuration are not reset to the default values. 

 

Table 13: Explanations to the Dialog Pane Signal Configuration 

 

2. In the column Tag respectively enter the names of the tags for the 
single signals. 

3. In the column Data type respectively select the data types for the single 
signals. 
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4 Device Description 
4.1 About Device Description 

Descriptions of “Device Description” 
The table below gives an overview for the Device Description dialog 
panes descriptions: 
 

AS-Interface generic Slave DTM Folder Name / 
Section 

Page 

Navigation Area  

 Configuration 
 Device Description 

 Device Info 

  

Navigation Area - Description 

Device Info 25 

Table 14: Descriptions of the Dialog Panes Device Description 

 

 

 

4.2 Device Info 
The Device Info dialog contains manufacturer information about the 
device, which is defined in the EDS file. The following information is 
indicated: 
 

Parameter Meaning 
Vendor name Vendor name of the device 
Product name Name of the device 
Ident. number Identification number of the device 
Revision Hardware reference 
Icon file File name of the device icon 
Max input data length Max input data length in Bit 
Max output data 
length 

Max output data length in Bit 

Table 15: Explanations to the Dialog Pane Device Info 

 

 

 



Online Functions 26/42 

Generic Slave DTM for AS-Interface Slave Devices | Configuration of AS-Interface Slave Devices  
DOC090604OI07EN | Revision 7 | English | 2018-03 | Released | Public  © Hilscher, 2009-2018 

5 Online Functions 
5.1 Connecting/Disconnecting Device 

 

 
Note: To access to the diagnosis panes and to use the diagnosis, 
requires an online connection from the generic AS-Interface Slave DTM to 
the AS-Interface Master DTM. This online connection can only be build up 
if a driver is assigned to the AS-Interface Master device. 

 

 

For information on how to select a driver, to scan for a device and to 
select it in the Master DTM dialog, refer to the Operating Instruction 
Manual DTM for AS-Interface Master devices. 

Connecting Device 
The following steps are needed to establish a connection from the generic 
AS-Interface Slave DTM to the AS-Interface Master DTM: 

1. In the Master DTM dialog verify that the default driver is checked and 
respectively check another or multiple drivers. 

2. Configure the driver, scan for the device and select it and select and 
download the firmware. 

3. Close the user dialog of the AS-Interface Master DTM via the OK 
button. 

4. Put a right-click on the device icon of the generic AS-Interface Slave. 

5. Select the Connect command from the context menu (right mouse 
button). 

 The generic AS-Interface Slave DTM now is connected to the AS-
Interface Master DTM via an online connection. In the network view the 
device description at the device icon is displayed with a green colored 
background. 

Disconnecting Device 
The following steps are needed to disconnect an online connection from the 
generic AS-Interface Slave DTM to the AS-Interface Master DTM: 

1. Close the user dialog of the generic AS-Interface Slave DTM via the OK 
button. 

2. Right-click on the device icon of the generic AS-Interface Slave. 

3. Select the Disconnect command from the context menu (right mouse 
button). 

 The online connection from the generic AS-Interface Slave DTM to the 
AS-Interface Master DTM is disconnected. In the network view the 
device description is displayed not any more with a green colored 
background. 
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6 Diagnosis 
6.1 Overview Diagnosis 

The dialog Diagnosis serves to diagnose the device behavior and 
communication errors. For diagnosis the device must reside in online state.  

Diagnosis Panes 
The table below gives an overview for the individual Diagnosis dialog 
panes descriptions: 
 

AS-Interface generic Slave DTM Folder Name / Section Manual Page 

Navigation Area  

 Diagnosis 
 General Diagnosis 

  

Navigation Area - Diagnosis 

General Diagnosis 28 

Table 16: Descriptions of the Diagnosis Panes 

Online Connection to the Master DTM 

 
Note: Accessing the Diagnosis panes of the AS-Interface generic Slave 
DTM requires an online connection from the AS-Interface generic Slave 
DTM to the AS-Interface Master DTM. For further information refer to 
section Connecting/Disconnecting Device on page 26. 

 

 



Diagnosis 28/42 

Generic Slave DTM for AS-Interface Slave Devices | Configuration of AS-Interface Slave Devices  
DOC090604OI07EN | Revision 7 | English | 2018-03 | Released | Public  © Hilscher, 2009-2018 

6.2 General Diagnosis 
The diagnosis indicates the Slave status as well as whether a peripheral 
fault has occurred. This is displayed in the General Diagnosis dialog. 

 
Figure 10: General Diagnosis 

 

Indication Meaning 
Slave status 
Slave detected 

 
 

When the “Slave detected” LED turns to green, the AS-Interface Slave has been detected 
by the Master (through the start up operation or inclusion phase). [2] 

Slave projected 
 
 

When the “Slave projected” LED turns to green, the AS-Interface Slave has been configured 
in the internal Master device list of projected Slave devices. [2] 

Slave activated 
 
 

When the “Slave activated” LED turns to green, the AS-Interface Slave has been activated 
during start up operation or inclusion phase. [2] 

Peripheral fault 
 
 

When the “Peripheral fault” LED turns to red, at the AS-Interface Slave a peripheral fault has 
been detected. [2] 

Update The diagnosis information can be updated “Once” or on “Cyclic” basis. 
Once Select Once to update the information immediately, just once. 

Cyclic Select Cyclic and Start to update the information cyclic. 
Then the information is updated about every 250 ms. 
Select Stop to stop the cyclic update. 

Start (Stop) Starts and stops updating the diagnostic info for cyclic update mode.  

Table 17: Indication General Diagnosis 
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7 Appendix 
 

7.1 User Rights 
User-rights are set within the FDT-container. Depending on the level the 
configuration is accessible by the user or read-only. 

To access the Configuration and Device Description panes of the 
Generic AS-Interface Slave DTM you do not need special user rights. Also 
all users can select the decimal or hexadecimal Display mode or sort table 
entries. 
 

 
Note: To edit, set or configure the parameters of the Configuration 
panes, you need user rights for Maintenance, for Planning Engineer or for 
Administrator. 

 

The following tables give an overview of the user right groups and which 
user rights you need to configure the single parameters. 
 

7.1.1 Configuration 
 Observer Operator Maintenanc

e 
Planning 
Engineer 

Administra
tor 

General D D X X X 
Configuration D D X X X 
Signal Configuration D D X X X 

Table 18:  Configuration (D = Displaying, X = Editing, Configuring) 
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7.2 I/O Code, ID Code, ID2 Code and Slave Profiles 
The I/O Code describes the direction of the data bits of a Slave. This can 
be: input, output, Bi-directional or Tristate. 

The ID Code and ID2 Code are programmed by the production of a Slave 
and can not be changed by the user. They serve for the identification of the 
Slaves, which correspond to a fixed profile.  

The identification of a Slave has to be done like the following: 

S-[I/O-Code].[ID-Code].[ID2-Code]. 
 

I/O Code  I/O Configuration 
(4 Bit) D0 D1 D2 D3 
0x0 IN IN IN IN 
0x1 IN IN IN OUT 
0x2 IN IN IN I/O 
0x3 IN IN OUT OUT 
0x4 IN IN I/O I/O 
0x5 IN OUT OUT OUT 
0x6 IN I/O I/O I/O 
0x7 I/O I/O I/O I/O 
0x8 OUT OUT OUT OUT 
0x9 OUT OUT OUT IN 
0xA OUT OUT OUT I/O 
0xB OUT OUT IN IN 
0xC OUT OUT I/O I/O 
0xD OUT IN IN IN 
0xE OUT I/O I/O I/O 
0xF TRI TRI TRI TRI 

Table 19: Possible I/O Codes of a Slave 

 

IN = Input data 
OUT = Output data 
I/O = In- and Output data 
TRI = Tristate 

For example the I/O Code 7 of a Slave:  

If a Slave has this profile all four data bits can be read and written, they are 
bi-directional. For this profile various ID Codes are already defined. 
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Slave Profile 
 

ID Code 
0 1 2 3 4 5 6 7 8 9 A B C D E F 

I/O
 C

od
e 

0 I, I, I, I - 0.1  

A
/B

 Slaves 

0.B  

Free Profiles 

1 I, I, I, O - 1.1   

2 I, I, I, B -   

3 I, I, O, O - 3.1   

4 I, I, B, B -   

5 I, O, O, O X.0   

6 I, B, B, B -   

7 B, B, B, B - 7.1 7.2 7.3 7.4  7.B  7.D 7.E 

8 O, O, O, O - 8.1   

9 O, O, O, I   

A O, O, O, B X.0   

B O, O, I, I  B.1   

C O, O, B, B X.0   

D O, B, B, B  D.1   

E O, B, B, B X.0   

F T, T, T, T  

Table 20: Defined Slave profiles (released 01.03.2000) 

I = Input data 
O = Output data 
B = In- and Output data 
T = Tristate 

The defined Slave profiles exist for: 

I/O=X, ID=F free profiles (X=O...E) 

I/O=X, ID=0 remote I/O ports (X=0...E, not 9, B, D) 

I/O=X, ID=A reserved for A/B Slaves (X=0...E, not 2, A) 

I/O=0, ID=1  two dual-signal sensors 

I/O=0, ID=B reserved for safety oriented sensors 

I/O=1, ID=1  single sensor with extended control 

I/O=3, ID=1  one dual-signal sensor, one dual actuator 

I/O=3, ID=A sensor with extended address function 

I/O=7, ID=1  interface for the transfer of 6 to 18-bit signals 

I/O=7, ID=2  extended Slave profile for the transmission of 6 to 
   21-bit signals 

I/O=7, ID=3 extended Slave profile for the transmission of  
   16 bit signals 

I/O=7, ID=4 extended Slave profile for the transmission of  
   16 bit signals to 4 bit digital values 
 

 
Note: This table shows the defined Slave Profiles from the state 
01.03.2000. Further extensions are possible. 

 

The profile S-7.1 for example describes a device for the transmission of 6 
to 18 bit signals (analog profile), the profile S-7.2 describes a device for the 
transmission of 6 to 21 bit signals (extended analog profile) and so on. 
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7.3 I/O Data Size depending by IO and ID Code 
The table AS-Interface Slave Type on page 33 contains an overview of the 
AS-Interface Slave profile types. The table shows the input or output data 
transmitted by the AS-Interface Slave devices depending by the IO or the 
ID Codes or the AS-Interface Slave profiles. 
 

CCT Value 
 

The CCT value (Combined Transaction Type) represents a general 
category to categorize the Slave profile types. 
 

Transparent or analog I/O Data 
 

In general transparent (mostly digital) or analog I/O data are distinguished. 
The data structure of the analog I/O data is defined in the AS-Interface 
specification. In spite of the data structure for the transparent I/O data is not 
defined there. Often the transparent data are digital values.  
 

 

Please refer to the manufacturer manual of the device, to get more 
information on how the data structure of the transparent I/O data for the 
Slave device is defined. 

 

Channel Size 
 

 
Note: The AS-Interface specification defines for the I/O data a channel 
size of 16 Bit.   
For CCT-2 profiles each the possible maximum value for the transmitted 
I/O data is configured. 

 

CCT-2 Slave Profile 
 

For devices configured via a CCT-2 profile, in the configuration software the 
maximum value for the transmitted I/O data is configured. 

The I/O data displayed in the signal table correspond to this maximum 
value and do not show the size of the I/O data transmitted by the device. 
 

 

Please refer to the manual of the Slave device manufacturer, to get the 
value of the size of the valid I/O data for the Slave device that are used or 
can be transmitted. 

 
 

Default Value 
 

The default value for the analog input data depends on whether analog 
or digital data are transmitted or changes depending from the Slave profile 
or the ID or ID2 code. 
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7.3.1 AS-Interface Slave Types 
 

AS-Interface Slave Profile Types 
CTT IO ID 

Code 
ID1 ID2 Input Output Note Default 

values 
for 
analog 
input 
channels 

1 7 3 - 0   16 Bit (Transparent) 1 Channel 16 Bit  

1 7 3 - 1   32 Bit (Transparent) 2 Channel 16 Bit   

1 7 3 - 2   64 Bit (Transparent) 4 Channel 16 Bit   

1 7 3 - 4   16 Bit (Analog) 1 Channel 16 Bit   

1 7 3 - 5   32 Bit (Analog) 2 Channel 16 Bit   

1 7 3 - 6   64 Bit (Analog) 4 Channel 16 Bit   

1 7 3 - 8 16 Bit (Transparent)   1 Channel 16 Bit 0x0000 

1 7 3 - 9 32 Bit (Transparent)   2 Channel 16 Bit 0x0000 

1 7 3 - A 64 Bit (Transparent)   4 Channel 16 Bit 0x0000 

1 7 3 - C 16 Bit (Analog)   1 Channel 16 Bit 0x7FFF 

1 7 3 - D 32 Bit (Analog)   2 Channel 16 Bit 0x7FFF 

1 7 3 - E 64 Bit (Analog)   4 Channel 16 Bit 0x7FFF 

1 7 4 - 0 4 Bit 4 Bit Transparent Digital In/Out   

1 7 4 - 4   16 Bit 1 Channel 16 Bit (analog or 
digital depend on  

0x7FFF 
(0x0000) 

1 7 4 - 5   32 Bit 2 Channel 16 Bit (analog or 
digital depend on  

0x7FFF 
(0x0000) 

1 7 4 - 6   64 Bit 4 Channel 16 Bit (analog or 
digital depend on  

0x7FFF 
(0x0000) 

1 7 4 - C 16 Bit   1 Channel 16 Bit (analog or 
digital depend on  

0x7FFF 
(0x0000) 

1 7 4 - D 32 Bit   2 Channel 16 Bit (analog or 
digital depend on  

0x7FFF 
(0x0000) 

1 7 4 - E 64 Bit   4 Channel 16 Bit (analog or 
digital depend on  

0x7FFF 
(0x0000) 

1 7 4 - F 64 Bit (input or output depend on ID 
string) 

4 Channel 16 Bit (analog or 
digital depend on  

0x7FFF 
(0x0000) 

2 7 5 - 5 64 Bit + 2 Bit 64 Bit + 2 Bit 1 channel input and output, both 
up to 64(32) Bit (can be less). 
Dependent on "ID object" 

0x7FFF 
(0x0000) 

2 7 A - 5 32 Bit + 2 Bit 32 Bit + 1Bit 0x7FFF 
(0x0000) 

2 B A - 5 32 Bit 32 Bit 0x7FFF 
(0x0000) 

3 7 A 7 7 4 Bit (Transparent) 4 Bit     

3 7 A 6 A 8 Bit (Transparent) 8 Bit non consistent input (1Ch. 16Bit) 0x0000 

3 7 A 7 A 8 Bit (Transparent) 8 Bit consistent input (1Ch. 16Bit) 0x0000 

4 7 A 3 8 8 Bit (Transparent) 1 Bit 1 Channel (left alignment 16Bit) 
+1Bit 

0x0000 

4 7 A 4 8 12 Bit (Transparent) 1 Bit 1 Channel (left alignment 16Bit) 
+1Bit 

0x0000 

4 7 A 5 8 16 Bit (Transparent) 1 Bit 1 Channel (left alignment 16Bit) 
+1Bit 

0x0000 
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AS-Interface Slave Profile Types 
CTT IO ID 

Code 
ID1 ID2 Input Output Note Default 

values 
for 
analog 
input 
channels 

4 7 A 6 8 12 Bit (Analog) 1 Bit 1 Channel (left alignment 16Bit) 
+1Bit 

0x7FFF 

4 7 A 7 8 14 Bit (Analog) 1 Bit 1 Channel (left alignment 16Bit) 
+1Bit 

0x7FFF 

4 7 A 0 9 14 Bit (Analog)   1 Channel (left alignment 16Bit) 0x7FFF 

4 7 A 1 9 12 Bit (Analog)   1 Channel (left alignment 16Bit) 0x7FFF 

4 7 A 2 9 14 Bit (Analog)   1 Channel (left alignment 16Bit) 0x7FFF 

4 7 A 3 9 14 Bit (Analog)   1 Channel (left alignment 16Bit) 0x7FFF 

4 7 A 4 9 28 Bit (Analog)   2 Channel (left alignment 16Bit) 0x7FFF 

4 7 A 5 9 28 Bit (Analog)   2 Channel (left alignment 16Bit) 0x7FFF 

4 7 A 6 9 14 Bit (Analog)   2 Channel (left alignment 16Bit) 0x7FFF 

4 7 A 7 9 28 Bit (Analog)   2 Channel (left alignment 16Bit) 0x7FFF 

5 6 0 - 2 8  Bit (Transparent) 8  Bit (Transparent) Allocate 2 Slave Address 0x0000 

5 6 0 - 3 12 Bit (Transparent) 12 Bit (Transparent) Allocate 3 Slave Address 0x0000 

5 6 0 - 4 16 Bit (Transparent) 16 Bit (Transparent) Allocate 4 Slave Address 0x0000 

5 6 0 - A 8  Bit (Analog) 8  Bit (Analog) Allocate 2 Slave Address 0x7FFF 

5 6 0 - B 12 Bit (Analog) 12 Bit (Analog) Allocate 3 Slave Address 0x7FFF 

5 6 0 - C 16 Bit (Analog) 16 Bit (Analog) Allocate 4 Slave Address 0x7FFF 

Table 21: AS-Interface Slave Types 

 

 
Note: All CTT-Slave profile types contained in the table AS-Interface 
Slave Type are processed by the AS-Interface Master device[2]. All other 
Slave-profile types can not be classified as CTT-Slave-profile types and 
each have 4-bit input and 4-bit output data, as defined in the table AS-
Interface Slave Type on page 31. 
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7.3.2 Examples for I/O Data Size depending on Slave Profile 
 

7.3.2.1 Profile S-7.3.2, 64 Bit Output Data (transparent) 
 

7. 3. 2 

/ I \ 

IO-Code ID-Code ID2-Code 
 

I/O Data: 64 Bit output (digital) 

The signal configuration for the AS-Interface Slave profile „7.3.2“ shows: 

• four transparent output modules of the data type „BIT“, e. g., 4 x 16 Bit 
output data (transparent). 

 
Figure 11: Signal Configuration Example „S-7.3.2“ 

 

7.3.2.2 Profile S-7.3.5, 32 Bit Output Data (analog) 
 

7. 3. 5 

/ I \ 

IO-Code ID-Code ID2-Code 
 

I/O data: 32 Bit output (analog) 

The signal configuration for the AS-Interface Slave profile „7.3.5“ shows: 

• two analog output modules of the data type „WORD“, e. g., 2 x 16 Bit 
output data (analog). 

 
Figure 12: Signal Configuration Example „S-7.3.5“ 
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7.3.2.3 Profile S-7.3.E, 64 Bit Input Data (analog) 
 

7. 3. E 

/ I \ 

IO-Code ID-Code ID2-Code 
 

I/O data: 64 Bit input (analog) 

Default for input data: 0x7FFF / 0x7FFF / 0x7FFF / 0x7FFF 

The signal configuration for the AS-Interface Slave profile „7.3.E“ shows: 

• four analog input modules of the data type „WORD“, e. g., 4 x 16 Bit 
input data (analog). 

 
Figure 13: Signal Configuration Example „S-7.3.E“ 

 
 
 

7.3.2.4 CCT-2 Profile S-7.5.5, 64 Bit+2 Bit Input- and 64 Bit+2 Bit Output Data 
(analog or transparent and digital) 

 

7. 5. 5 

/ I \ 

IO-Code ID-Code ID2-Code 
 

I/O data: 64 Bit input (analog or transparent) + 2 Bit input (digital) and 64 Bit 
output (analog or transparent) + 2 Bit output (digital) 
 

 

The default data depend on the device. For the default data refer to the 
respective manual of the Slave device manufacturer. 

 

 
Note: Regardless of the information in the manual, in case of device 
failure or protocol error in the input image of the process data the value 
"0x7FFF" can be displayed. The process data image can be viewed in the 
AS-Interface Master DTM. 

 

The signal configuration for the AS-Interface Slave profile „7.5.5“ shows: 

• one analog input module of the data type „WORD“, e. g., 64 (=4 x 16) Bit 
input data (analog or transparent), 

• one digital input module of the data type „Bit“, e. g., 2 Bit input data 
(digital), 

• one analog output module of the data type „WORD“, e. g., 64 (=4 x 16) 
Bit output data (analog or transparent), 

• one digital output module of the data type „Bit“, e. g., 2 Bit output data 
(digital). 
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Figure 14: Signal Configuration Example „S-7.5.5“ 

 
 

 

The number, size or assignment of the relevant I/O data depends on the 
IO object and is specified in the manual of the Slave device manufacturer. 
Please refer to the manual of the Slave device manufacturer, to get the 
value of the size of the valid I/O data for the Slave device that are used or 
can be transmitted. 

 
 



Appendix 38/42 

Generic Slave DTM for AS-Interface Slave Devices | Configuration of AS-Interface Slave Devices  
DOC090604OI07EN | Revision 7 | English | 2018-03 | Released | Public  © Hilscher, 2009-2018 

7.3.2.5 CCT-2 Profile S-7.A.5, 32 Bit+2 Bit Input- and 32 Bit+1 Bit Output Data 
(analog or transparent and digital) 

 

7. A. 5 

/ I \ 

IO-Code ID-Code ID2-Code 
 

I/O data: 32 Bit input (analog or transparent) + 2 Bit input (digital) and 32 Bit 
output (analog or transparent) + 1 Bit output (digital) 
 

 

The default data depend on the device. For the default data refer to the 
respective manual of the Slave device manufacturer. 

 

 
Note: Regardless of the information in the manual, in case of device 
failure or protocol error in the input image of the process data the value 
"0x7FFF" can be displayed. The process data image can be viewed in the 
AS-Interface Master DTM. 

 

The signal configuration for the AS-Interface Slave profile „7.A.5“ shows: 

• one analog input module of the data type „WORD“, e. g., 32 (=2 x 16) Bit 
Input Data (analog or transparent), 

• one digital input module of the data type „Bit“, e. g., 2 Bit Input Data  
(digital), 

• one analog output module of the data type „WORD“, e. g., 32 (=2 x 16) 
Bit Output Data (analog or transparent), 

• one digital output module of the data type „Bit“, e. g., 1 Bit Output Data 
(digital). 

 
Figure 15: Signal Configuration Example „S-7.A.5“ 

 
 

 

The number, size or assignment of the relevant I/O data depends on the 
IO object and is specified in the manual of the Slave device manufacturer. 
Please refer to the manual of the Slave device manufacturer, to get the 
value of the size of the valid I/O data for the Slave device that are used or 
can be transmitted. 
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7.3.2.6 CCT-2 Profile S-B.A.5, 32 Bit Input- or 32 Bit Output Data (digital)  
 

B. A. 5 

/ I \ 

IO-Code ID-Code ID2-Code 
 

I/O Data: 32 Bit input (digital) and 32 Bit output (digital) 
 

 

The default data depend on the device. For the default data refer to the 
respective manual of the Slave device manufacturer. 

 

 
Note: Regardless of the information in the manual, in case of device 
failure or protocol error in the input image of the process data the value 
"0x7FFF" can be displayed. The process data image can be viewed in the 
AS-Interface Master DTM. 

 

The signal configuration for the AS-Interface Slave profile „B.A.5“ shows: 

• one digital input module of the data type „BIT“, e. g., 32 Bit Input Data 
(digital), 

• one digital output module of the data type „BIT“, e. g., 32 Bit Output Data 
(digital). 

 
Figure 16: Signal Configuration Example „S-B.A.5“ 

 

 

The number, size or assignment of the relevant I/O data depends on the 
IO object and is specified in the manual of the Slave device manufacturer. 
Please refer to the manual of the Slave device manufacturer, to get the 
value of the size of the valid I/O data for the Slave device that are used or 
can be transmitted. 

 

 

7.4 References 
[1] Device Type Manager (DTM) Style Guide, Version 1.0 ; FDT-JIG - Order No. 

<0001-0008-000> 
[2] Complete Specification of the Actuator-Sensor-Interface, presently Version 3, 

Revision 2, dated July 9, 2008 
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Actuator-Sensor-Interface, presently Version 3, Revision 2, dated July 9, 2008 
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7.7 Glossary 
AS-Interface 

Actuator Sensor Interface, AS-I: A standard for field bus communication for 
connecting actuators and sensors according to EN 50295 and IEC 62026-
2. It is an industrial networking solution (physical layer, data access method 
and protocol) used in PLC, DCS and PC-based automation systems. It is 
designed for connecting simple field I/O devices (e.g. binary ON/OFF 
devices such as actuators, sensors, rotary encoders, analog inputs and 
outputs, push buttons, and valve position sensors) in discrete 
manufacturing and process applications using a single 2-conductor cable. 

CTT 

Combined Transaction Type (AS-Interface Slave-profile types, which differ 
at the protocol level.) 

DTM 

Device Type Manager 

The Device Type Manager (DTM) is a software module with graphical user 
interface for the configuration and/or for diagnosis of devices. 

EDS 

An Electronic Data Sheet (EDS) provides information necessary to access 
and alter the configurable parameters of a device. An Electronic Data Sheet 
(EDS) is an external file that contains information about configurable 
attributes for the device – extended ID1, ID2 (if supported) codes and 
parameter data description. 

FDT 

Field Device Tool 

FDT specifies an interface, in order to be able to use DTM (Device Type 
Manager) in different applications of different manufacturers. 
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